WARNING

• If an error or improper operation occurs in our product, or customer-made programs should be found defective, protection and safety circuits, etc should be provided for safety of the system to be used. In addition, safety measures should be taken against personal injury or fatal accident to the system.

• A part or all of the information contained herein is prohibited from duplication without Fuji's written consent.

• This manual is subject to change without previous notice.

• Although we always keep track of the information contained herein to assure accuracy, Fuji will not be responsible for any damage to the system due to mistakes, skip or misuse in writing.

• Be sure to read the Readme.text file included in CD-ROM.

• Depending on the environment to be used and the usage, it may not operate normally.

• Please note that operation except the Personal Computer which made by maker, such as self-assembled PC and so on, cannot be guaranteed.

(Note) Windows 2000/XP/Me/98/95/NT/7 are registered trademarks of Microsoft Corporation.

Request

It is prohibited to transfer part or all of this manual without Fuji Electric's permission in written format.
Description in this manual will be changed without prior notice for further improvement.
## CONTENTS

1. OUTLINE.......................................................................................................................... 1
   1.1 Foreword....................................................................................................................... 1
   1.2 Parameter loader for paperless recorder................................................................. 1
   1.3 Contents of package..................................................................................................... 1
   1.4 Recommended operating environment ....................................................................... 1
   1.5 Installing the parameter loader for paperless recorder............................................. 2
   1.6 Installing USB communication driver ....................................................................... 2
   1.7 Uninstalling the parameter loader software for paperless recorder ......................... 7
   1.8 Cautions ....................................................................................................................... 7

2. BASIC OPERATION ...................................................................................................... 8
   2.1 Start........................................................................................................................... 8
   2.2 Table of setting channel display................................................................................ 9
   2.3 Setting channels ....................................................................................................... 14
      2.3.1 Copying the channel set .................................................................................... 18
   2.4 Setting math channels .............................................................................................. 20
      2.4.1 Setting of arithmetic expression ....................................................................... 21
      2.4.2 Copying of math channel .................................................................................. 22
   2.5 Setting the main unit .................................................................................................. 23
      2.5.1 DI function (external control unit) setting (option)............................................ 24
   2.6 Display setting .......................................................................................................... 25
      2.6.1 Display setting..................................................................................................... 26
      2.6.2 Setting channels ................................................................................................. 26
      2.6.3 Setting message .................................................................................................. 27
      2.6.4 Unit coding ........................................................................................................ 28
   2.7 Ethernet communication setting ............................................................................... 29
   2.8 E-mail communication setting ................................................................................... 30
      2.8.1 E-mail trigger setting ......................................................................................... 31

Appendix.1 Example of setting parameters to be printed out......................................... 33
1. OUTLINE

1.1 Foreword

This instruction manual describes installation and operation for the parameter loader of the paperless recorder. Read it carefully before use.

1.2 Parameter loader for paperless recorder

Connect the parameter loader (hereafter referred to as loader) to the paperless recorder using commercially available USB cable or LAN cable, and referencing (uploading), editing, and setting (downloading) of each parameter of the paperless recorder can be made. Connect USB miniB type male connector to the paperless recorder.

Note: Optionally available dedicated cable is required to use the loader for program versions V01A to V22A of the paperless recorder PHR main unit.

1.3 Contents of package

The following items are packaged with the product.

• CD-ROM for installation: 1
• Instruction manual which is installed to above CD-ROM

1.4 Recommended operating environment

• Microsoft Windows 2000 or XP or Windows 7 (Home Premium, Professional (Not applicable for 64 bit version)). (Operation by Windows 95/98/Me/NT is not secured.)
• Hard disk with a free capacity of 30MB or more
• RAM with 64MB or more
• USB port
• USB cable [USB(A) male–USB(miniB) male, or Type PHZP1801]
• LAN port (when provided with Ethernet option)
• LAN cable (when provided with Ethernet option)

Note: Hardware requirements of the loader are as follows when it is used for program versions V01A to V22A of the paperless recorder PHR.

• RS-232C serial port (D-sub 9 pin)
• Communication cable dedicated to parameter loader (Option: PHZP0201)
1.5 Installing the parameter loader for paperless recorder

1) If other application software programs are open, terminate all of them.
2) If the programming loader has been already installed, open “Add/Remove Programs” on Control Panel and delete the parameter loader.
3) Set CD-ROM in the personal computer drive.
4) Start “Setup. exe” in the CD-ROM.
5) Follow the prompts displayed on the screen.
6) Please install the main body of the parameter loader.
   A message is displayed, prompting you to verify that “Parameter loader setup is complete”.
   Now, the Parameter Loader installation is completed.

1.6 Installing USB communication driver

The driver can be installed on Windows XP as follows for example.
1) Connect the USB port of the paperless recorder whose power has been turned on and a running PC with a USB cable.
2) The message “Found New Hardware” and then the driver installation wizard appear on the computer. Click the [Next] button.
3) When the dialog box below is displayed, select [Display a list of the known drivers for this device so that I can choose a specific driver] and click the [Next] button.

4) The dialog box below is displayed. Select [Other Devices] and click the [Next] button.

5) The dialog box below is displayed. Click [Have Disk].
6) The [Install From Disk] dialog box is displayed. Click the [Browse] button.

7) The USB driver “OP-U.inf” is automatically stored in the “inf” folder within the install folder (“C: ¥ Program Files ¥ ParameterLoader” usually) of the parameter loader. Select the “OP-U.inf” file and then click “Open.”

8) The previous dialog box is displayed again. Check the path shown under [Copy Manufacturer’s Files From:] and click the [OK] button.

9) The dialog box below is displayed. Check that [Operation Panel USB Driver] is shown under [Models:]. Click the [Next] button.
10) The driver installation starts.

11) The dialog box below is displayed on completion of installation. Click the [Finish] button.
Recognition of USB Driver

When the driver has been installed successfully and the paperless recorder and the computer are connected with a USB cable, the [Device Manager] window shows “Operation Panel - Operation Panel USB Driver.”

This will disappear when the paperless recorder and the computer are disconnected.

If [Other Device] or [?] is shown even while their connection via USB is maintained, the USB driver may not be recognized. If this happens, uninstall the USB driver once and reinstall it.
1.7 Uninstalling the parameter loader software for paperless recorder

For un-installation of the parameter loader for the paperless recorder, proceed from Start of Windows → Setting → Control Panel → Add or delete application. And select Recorder Parameter Loader and follow Windows’ instructions and cautions to delete it. When you install a different version, be sure to un-install the software, which is currently installed, in advance in the above procedures. If not un-installed, it might result in malfunctions such as not starting.

1.8 Cautions

When operating the Loader, be careful of the following items:

1) The Loader is used for the paperless recorder only.
2) Initial values on each Loader screen may be different from those of the paperless recorder main unit.
3) For the communication setting for the paperless recorder (“Main Unit Set” → “Communication Setting”), the Front communication function should be set to ON. (After the Front communication function has been switched from OFF to ON, turn OFF the power once, and then turn it ON.)
4) Before starting the paperless recorder, be sure to assure that the Loader setting is reflected to the paperless recorder.
5) The Loader cannot use more than 1 window at the same time.
   If more than 1 window is open, leave only a single window open and close all of other windows (this can be checked on the Window menu).
6) Whenever you want to write the setting data on parameter loader into paperless recorder, please return the display of paperless recorder to Display Mode such as Real Time Trend Screen. Don’t display Parameter Setting Screen, or this loader software may miss to write into the paperless recorder.
7) When you use this loader to write into the paperless recorder PHR which the program version is V01A to V05A, and you change the input type to 0 to 5Vdc, paperless recorder receives the input type as 1 to 5Vdc instead of 0 to 5Vdc. And then, this loader’s setting is also changed to 1 to 5Vdc. (This is because the main unit does not support 1 to 5Vdc input function.)
8) At this loader, some parameters which do not exist on paperless recorder may be displayed. But the parameter which doesn’t exist in paperless recorder isn’t written.
9) **During the paperless recorder is recording or totalizing, it is impossible to write into the equipment from this parameter loader.**
2. BASIC OPERATION

2.1 Start

Click “Programs” ⇒ “Recorder Parameter Loader” ⇒ “Recorder Parameter Loader” from the Start menu.

It is displayed such as following screen.

Note) The screen for maximum channels is displayed, regardless of the number of channels of the paperless recorder.
2.2 Table of setting channel display

<table>
<thead>
<tr>
<th>(1) Selection of setting model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting model can be selected by the parameter loader.</td>
</tr>
</tbody>
</table>

Display contents or setting range on the setting screen varies with each model.

<table>
<thead>
<tr>
<th></th>
<th>PHR</th>
<th>PHW</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel setting</td>
<td>18 channels (ch1 to 18)</td>
<td>36 channels (ch1 to 36)</td>
</tr>
<tr>
<td>Calculation channel setting</td>
<td>12 channels (ch19 to 30)</td>
<td>36 channels (ch37 to 72)</td>
</tr>
<tr>
<td>DI setting</td>
<td>10</td>
<td>16</td>
</tr>
<tr>
<td>DO setting</td>
<td>28</td>
<td>36</td>
</tr>
<tr>
<td>Screen group setting</td>
<td>4 groups</td>
<td>8 groups</td>
</tr>
</tbody>
</table>
(2) Communication setting
The setting on the communication with the paperless recorder can be made.

a) Communication
The communication method with the paperless recorder can be selected from USB, Ethernet, and RS-232C.

Note:
1) USB or Ethernet communications cannot be conducted if the program version of the paperless recorder PHR is V01A to V22A. Make sure to set the station No. of the parameter loader to 1.
2) RS-232C communications cannot be conducted if the program version of the paperless recorder PHW or PHR is V27A or later. Note that to conduct Ethernet communications, optional Ethernet communication board is necessary. To conduct USB communications, make sure to set the station No. of the parameter loader to 1.

b) IP Address, Station No.
Setting is necessary to conduct Ethernet communications with the paperless recorder. IP Address and Station No. of the paperless recorder can be set.
c) Port

Setting is necessary to conduct RS-232C communications with the paperless recorder. The communication port of the PC used to communicate with the paperless recorder can be set. This function can change communication port of PC which communicates with paperless recorder. At starting of this loader, COM1 is selected as communication port. Set the port number that you want to use at first.

At the executing screen, click [Com(R)] → [Port(P)] and select using port. Normally, COM1 is selected. (Normally COM1 is selected.)

(3) Upload setting value from the paperless recorder

It is available to upload all the setting such as channel setting, math channel setting, main setting, display setting and so on from the paperless recorder.

(4) Download setting value to the paperless recorder

It is available to download all the setting such as channel setting, math channel setting, main setting, display setting and so on to the paperless recorder.

Note: 1) Download prohibit during recording or totalizing.

2) After the data has been downloaded to the paperless recorder, store non-volatile memory, or the setting value will return to the former value when power is turned OFF.

(5) The data downloaded to the paperless recorder can be stored non-volatile memory.

(6) Time setting to the paperless recorder

It is available to change time setting of the paperless recorder. Press [Time setting] button, and screen as shown below appears. Set the time that you want to change. And then press [Change] button.

Note: 1) This setting prohibit during recording or totalizing.

2) This setting is not necessary to be stored non-volatile memory.
(7) File menu
This menu, you can use functions as shown below.

- **a) [Open(O)]**
  
  Paperless recorder parameter setting files stored in your PC can be opened. Parameter setting files stored in the paperless recorder can also be opened.

- **b) [Save in file(S)]**
  
  Parameters currently being set can be stored in your PC. For parameter setting file to be created, extensions vary depending on setting model.
  
  In case of PHR: ******PHR
  
  In case of PHW: ******PHW
  
  Parameter setting file to be created: *****.PHR
  
  Substitute ***** with an arbitrary name. Select a file name consisting of alphanumeric characters with 7 uppercase characters or less when a parameter setting file is to be read from a compact flash card to the paperless recorder.
  
  Example:
  
  OK: PARA00.PHR, P123456.PHR  
  NG: Para00.PHR, P1234567.PHR

Note) To write the setting file in the compact flash card, which was created by the parameter loader, to a older version of the paperless recorder (V39A or older), be sure to perform the following settings:

1. Set “0” for the password for starting/stopping the recording. If a value other than “0” is set, a password setting screen appears when the recording starts/stops.
2. Select “Display only” for all the recording operation settings of the Math channel. If an item other than “Display only” is selected, a measured value of the Math channel is recorded when recording.

However, if you write a setting value via communication, the above problems do not occur. If a password setting screen appears when the recording starts/stops or a measured value of the Math channel is recorded due to the reasons mentioned above, initialize the setting values and perform the settings again.
c) Output setting value as text data.
   Please refer to attached “Appendix. 1: Example of setting parameters to be printed out.”

d) Exit menu.
   Note: 1) If you change setting value of the paperless recorder, register the setting value before
   exit this software.
   2) If you want to use setting value on another day, it is recommended to save the setting
   value file of the paperless recorder before exit this software.

(8) Copy the setting value

Copy the setting value such as channel setting, main setting, display setting and so on.
Click in line of original data and press [Copy]. Click in line that you want to copy, and then
press [Paste].
2.3 Setting channels

Set the parameter regarding to input, calculation, alarm, display and record of each channel. On “Table of setting channel display”, double-click the channel you want to change.

And then channel setting display appears.

* Settable number of channels depends on setting model.
  In case of PHR, it is available to set till 18ch regardless of number of channels.
  In case of PHW, it is available to set till 36ch regardless of number of channels.
* There are some screens to be able to display up to 7 characters as channel tag in spite of setting is available up to 8 characters. So don’t set 8 characters as channel tag.
* When you set out of the range, message as shown below appears.

Message in recording range

* Press [Apply] after changing channel setting, or your setting isn’t registered, so when you turn off and on the paperless recorder, setting value returns before you change.
* The input type becomes same kind in every two channels set.

(1) When input type of each channel is changed, setting is subjected to limitations.

  In case of PHR: The type setting of channel 2, 4, 6, 8, 11, 13, 15 and 17 is available only with
  the same input category of previous channel. Note that, channel 9 and 18 can
  select the input type regardless of other channels.

  In case of PHW: The type setting of channel 2, 4, 6, 8, 11, 13, 15, 17, 20, 22, 24, 26, 29, 31, 33
  and 35 is available only with the same input category of previous channel.
  Note that, channel 9, 18, 27 and 36 can select the input type regardless of
  other channels.

Input type is shown as follows.

<table>
<thead>
<tr>
<th>Input category</th>
<th>Input type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermocouple, 50mV</td>
<td>K-Type TC, E-Type TC, J-Type TC, T-Type TC, R-Type TC, S-Type TC, B-Type TC, N-Type TC, W-Type TC, L-Type TC, U-Type TC, PN-Type TC, 50mV</td>
</tr>
<tr>
<td>Resistance bulb</td>
<td>Pt100Ω, JPt100Ω</td>
</tr>
<tr>
<td>500mV</td>
<td>500mV</td>
</tr>
<tr>
<td>5V</td>
<td>1 to 5Vdc, 0 to 5Vdc</td>
</tr>
</tbody>
</table>

For example, when channel 1 is set to 1 to 5V, channel 2 is available to set only 1-5V, 0-5V, or
Skip as shown below.
Example: Setting input type of each channel

<table>
<thead>
<tr>
<th>Channel</th>
<th>Input type</th>
<th>Input type</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>K-Type TC</td>
<td>Thermocouple, 50mV</td>
<td>It is available to set any type of TC to each channel.</td>
</tr>
<tr>
<td>2</td>
<td>T-Type TC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1 to 5V</td>
<td>5V</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0 to 5V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Pt100</td>
<td>Resistance bulb</td>
<td>It is available to set any type of resistance bulb to each channel.</td>
</tr>
<tr>
<td>6</td>
<td>JPt100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>500mV</td>
<td>500mV</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>500mV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>J-Type TC</td>
<td>Thermocouple, 50mV</td>
<td>It is available to set any input type to channel 9.</td>
</tr>
<tr>
<td>10</td>
<td>K-Type TC</td>
<td>Thermocouple, 50mV</td>
<td>The same input type is basically allocated to 2 channels.</td>
</tr>
<tr>
<td>11</td>
<td>50mV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Skip</td>
<td>5V</td>
<td>It is available to set skip under any input type.</td>
</tr>
<tr>
<td>13</td>
<td>1 to 5V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Pt100</td>
<td>Resistance bulb</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Skip</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Skip</td>
<td>500mV</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>500mV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>50mV</td>
<td>Thermocouple, 50mV</td>
<td>It is available to set any input type to channel 18.</td>
</tr>
</tbody>
</table>

(2) When the input type of the channel is changed, the initialization of the input type of next channel might be required.

In case of PHR:
When the input type for channels 1, 3, 5, 7, 10, 12, 14 and 16 is changed, the initialization of the next channel might be required.

In case of PHW:
When the input type for channels 1, 3, 5, 7, 10, 12, 14, 16, 19, 21, 23, 25, 27, 30, 32 and 34 is changed, the initialization of the next channel might be required. When the initialization of the next channel is required, when the “Application” button is pressed, the following message screen appears.

![Message screen](image)

At this screen, if you press [OK] button, the input type of next channel is initialized to the same input type of current displayed channel. In case of 50mV, the next channel becomes K-type TC. In case of resistance bulb, the next becomes Pt100Ω.
* When you set input unit, set ON the “Scaling” at first. And then press “SELECT” key.
  In case of Thermocouple or Resistance bulb input, it is available to select either Celsius or Fahrenheit. And the others unit are not displayed.

The Unit Select screen appears. On the screen that is displayed, click a unit and press the [Apply] button. Note that the unit cannot be selected without pressing the [Apply] button.

Example: At voltage input and scaling ON
2.3.1 Copying the channel set

This screen allows you to copy one or more set values from one channel to another.
Move the cursor to CH on the Table of Setting Channel display, and click it (channel selection).
Click [Edit] → [Copy].

Move the cursor to CH where you want to paste channel settings and click it (channel selection).
Click [Edit] → [Paste].
Next, the following message appears, prompting you to select the option. Click [OK] when you want to copy the channel setting.

If the input type is different between current type and new one, the paperless recorder works such as below.

(1) Copying of Channel Setting in PHR

1) When the copy destination is channels 1 to 8, and 10 to 17:
   The same input types (*2) are used for their paired channels (*1).
   (*1: The paired channels are 1ch and 2ch, 3ch and 4ch, 5ch and 6ch, 7ch and 8ch, 10ch and 11ch, 12ch and 13ch, 14ch and 15ch, and 16ch and 17ch.)
   (*2: The K thermocouple input is used for the thermocouple, and the Pt100Ω input for the resistance thermometer.)

2) When the copy destination is 9ch and 18ch:
   No channel changes other than 9ch and 18ch.

(2) Copy of Channel Setting in PHW

1) When the copy destination is channels 1 to 8, 10 to 17, 19 to 26, and 28 to 35:
   The same input types (*2) are used for their paired channels (*1).
   (*1: The paired channels are 1ch and 2ch, 3ch and 4ch, 5ch and 6ch, 7ch and 8ch, 10ch and 11ch, 12ch and 13ch, 14ch and 15ch, 16ch and 17ch, 19ch and 20ch, 21ch and 22ch, 23ch and 24ch, 25ch and 26ch, 28ch and 29ch, 30ch and 31ch, 32ch and 33ch, and 34ch and 35ch.)
   (*2: The K thermocouple input is used for the thermocouple, and the Pt100Ω input for the resistance thermometer.)

2) When the copy destination is 9ch, 18ch, 27ch and 36ch:
   No channel changes other than 9ch, 18ch, 27ch and 36ch.

![Channel Copy](image)
2.4 Setting math channels

Set the parameter regarding to formula, input, totalize, alarm, display and record of each math channel. On “Table of setting math channel display”, double click the channel you want to change.

And then math channel setting display appears.

* Number of math channels differs according to model setting.
  When PHR is selected : It is available to set till 12 channels between ch19 and ch30.
  When PHW is selected : It is available to set till 36 channels between ch37 and ch72.
* There are some screen to be able to display up to 7 characters as channel tag in spite of setting is available up to 8 characters. So don’t set 8 characters as channel tag.
* When you set out of the range, message as shown below appears.

Message in recording range

* Press [Apply] after changing channel setting, or your setting isn’t registered, so when you turn off and on the recorder, setting value returns before you change.
### 2.4.1 Setting of arithmetic expression

Click the “Setting” button in the computing channel setting screen.

The arithmetic expression setting screen appears.
Select an arithmetic function and an input value and click “OK”.

#### List of functions usable for arithmetic expression

<table>
<thead>
<tr>
<th>Display</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No display</td>
<td>No arithmetic operation</td>
<td>No arithmetic operation is performed. The input value is used as it is.</td>
</tr>
<tr>
<td>ABS(A)</td>
<td>Absolute value</td>
<td>The absolute value of the value in the input A is found.</td>
</tr>
<tr>
<td>POW(A,B)</td>
<td>Exponentiation</td>
<td>The “input B” power of the value in the input A is calculated.</td>
</tr>
<tr>
<td>SQR(A)</td>
<td>Square root</td>
<td>The square root of the value in the input A is calculated.</td>
</tr>
<tr>
<td>LOG(A)</td>
<td>Log</td>
<td>The common logarithm in the input A is calculated.</td>
</tr>
<tr>
<td>LN(A)</td>
<td>LN</td>
<td>The natural logarithm in the input A is calculated.</td>
</tr>
<tr>
<td>EXP(A)</td>
<td>EXP</td>
<td>“e exponentiation” of the value in the input A is calculated.</td>
</tr>
<tr>
<td>RH(A,B)</td>
<td>Humidity</td>
<td>The relative humidity is calculated when the input A is dry-bulb temperature.</td>
</tr>
<tr>
<td>MAX(A,B)</td>
<td>Maximum value</td>
<td>The inputs A and B are compared to find the bigger value.</td>
</tr>
<tr>
<td>MIN(A,B)</td>
<td>Minimum value</td>
<td>The inputs A and B are compared to find the smaller value.</td>
</tr>
<tr>
<td>H-P(A)</td>
<td>Maximum value</td>
<td>The maximum value in the input A during a specified time is found.</td>
</tr>
<tr>
<td>L-P(A)</td>
<td>Minimum value</td>
<td>The minimum value in the input A during a specified time is found.</td>
</tr>
<tr>
<td>AVG(A)</td>
<td>Average value</td>
<td>The average value in the input A during a specified time is calculated.</td>
</tr>
<tr>
<td>SUM(A,B)</td>
<td>Cumulative value</td>
<td>The cumulative value in the input (A/B) during a specified time is calculated.</td>
</tr>
</tbody>
</table>

#### List of inputs usable for arithmetic expression

<table>
<thead>
<tr>
<th>Display</th>
<th>Content</th>
<th>Display example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>Channel input</td>
<td>C01</td>
</tr>
<tr>
<td>Cumulating calculation</td>
<td>Channel cumulative value</td>
<td>T01</td>
</tr>
<tr>
<td>DI</td>
<td>DI input</td>
<td>D01</td>
</tr>
<tr>
<td>Communication</td>
<td>Communication input</td>
<td>M01</td>
</tr>
<tr>
<td>Constant</td>
<td>Constant</td>
<td>K01</td>
</tr>
<tr>
<td>Temporary data</td>
<td>Result of the last expression</td>
<td>B01</td>
</tr>
</tbody>
</table>
2.4.2 Copying of math channel

A setting value is copied to other computing channel.

Put the cursor on the channel to be copied in the math channel setting list screen, and click it (channel selection).

Click the “Edit” menu and select “Copy”.

Click “Copy”. Select channel.

Put the cursor on the copy destination and click it (channel selection).

Click the “Edit” menu and select “Paste”.

Select “Paste”. Select “CH”.

Then the confirmation message appears.

When the “OK” button is pressed, copying is performed.
2.5 Setting the main unit

This screen allows you to set the recorder main unit.
Move the cursor to “Main setting” on the Table of Setting Channel display, and click it.

![Parameter Loader screenshot]

The Main unit Set screen appears.
* Settable items vary depending on setting model.
  (The above screen is displayed when the setting model is PHR.)
* If values are entered over the specified range, the following message appears.

![Parameter loader message]

Alarm Hysteresis message
2.5.1 DI function (external control unit) setting (option)

The DI function determines whether ON/OFF input from external devices connected to external terminal is accepted or not.

DI point varies depending on setting model.

PHR: DI1 to DI10 (Max. 10 points)

PHW: DI1 to DI16 (Max. 16 points)

Note: Without the DI option, DI function cannot be used.
2.6 Display setting

At this screen, you can see or set regarding to screen setting such as structure of screen, trend display screen and so on. Click “Display setting” tab of Structure of setting channel display.

Setting screen appears and you can see status about screen setting.
2.6.1 Display setting

At this screen, you can set regarding to screen setting such as structure of screen, trend display screen and so on. Double click the group No. at “Display group” column on Display setting screen.

* Edit the displayed group on “Selected group No.”.
* Screen name (up to 16 characters) can be set to the recorder.
* If scale display is ON, trend screen is divided in accordance with the scale, not the setting of “Display divided”.

2.6.2 Setting channels

Set the structure of screen.
No.1 at this screen equals to data 1 of “display setting” of the paperless recorder, No.2 equals to data 2. Following is the same as above until No.10.
* In case of the paperless recorder is 9 inputs type, this screen displays until No.10.
2.6.3 Setting message

The screen allows you to set messages to be displayed when an event occurs.
Move the cursor to No. of the Message box on the Main Unit Set screen and double-click it.

The Message Setting screen appears.

* Up to 32 characters is available for the message. The characters exceeding 32 cannot be displayed on the recorder main unit.

* After the input of message set data, be sure to press the “Apply” button, or the message cannot be registered.

* Message timing is allocated as follows:
2.6.4 Unit coding

Units can be made in alphanumerical characters. This unit can be registered in the input unit when scaling is set to ON on the Channel Setting screen.

Move the cursor to No. of the Unit box on the Main Unit Set screen and double-click it.

![Unit Setting screen](image)

The Unit Setting screen appears.

* A message (unit) consisting of up to 7 characters is available for the recording main unit.

* After the input of unit set data, be sure to press the “Apply” button, or the unit cannot be registered.
2.7 Ethernet communication setting

Settings related to Ethernet communications such as IP address, user name, operation setting of each Ethernet communication function of the paperless recorder can be checked or made.

* Ethernet communication function cannot be used unless the paperless recorder main unit is provided with Ethernet communication option.

* Up to 16 characters can be entered as user name.

* Up to 8 characters can be entered as password.
2.8 E-mail communication setting

Settings related to E-mail communications such as send/receive address and send trigger can be made.

* E-mail communication function cannot be used unless the paperless recorder main unit is provided with Ethernet communication option.

* Up to 64 characters can be entered as send/receive address.
* Up to 32 characters can be entered as sender name.
2.8.1 E-mail trigger setting

Other conditions for E-mail transmission can be selected as follows.
Move the cursor to “E-mail trigger” on the E-mail setting screen and double-click it.

- Up to 32 characters can be entered as the title of E-mail and comments 1 and 2.
- Be sure to press the [Apply] button to confirm the E-mail trigger setting data that has been entered.
- E-mail trigger timing is allocated as shown below.

- When sending E-mail by DI operation
- When sending E-mail by alarm operation
- When sending E-mail by alarm operation of the main unit
- When sending E-mail at fixed intervals
## APPENDIX.1  EXAMPLE OF SETTING PARAMETERS TO BE PRINTED OUT

### Input Type
<table>
<thead>
<tr>
<th>Color</th>
<th>Tag No. 1</th>
<th>Tag No. 2</th>
<th>Input Unit</th>
<th>Other CH</th>
<th>Scaling</th>
<th>Measuring Range</th>
<th>Engineering Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sky blue</td>
<td>01</td>
<td>02</td>
<td>°C</td>
<td>channel 1</td>
<td>OFF</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Yellow</td>
<td>03</td>
<td>04</td>
<td>°C</td>
<td>channel 2</td>
<td>OFF</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Violet</td>
<td>05</td>
<td>06</td>
<td>°C</td>
<td>channel 3</td>
<td>OFF</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Green</td>
<td>07</td>
<td>08</td>
<td>°C</td>
<td>channel 4</td>
<td>OFF</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Purple</td>
<td>09</td>
<td>10</td>
<td>°C</td>
<td>channel 5</td>
<td>OFF</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Red</td>
<td>11</td>
<td>12</td>
<td>°C</td>
<td>channel 6</td>
<td>OFF</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Blue</td>
<td>13</td>
<td>14</td>
<td>°C</td>
<td>channel 7</td>
<td>OFF</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Indigo</td>
<td>15</td>
<td>16</td>
<td>°C</td>
<td>channel 8</td>
<td>OFF</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Dark blue</td>
<td>17</td>
<td>18</td>
<td>°C</td>
<td>channel 9</td>
<td>OFF</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

### Square rooter display filter PSV shift PV gain
<table>
<thead>
<tr>
<th>Input</th>
<th>Tag No. 1</th>
<th>Tag No. 2</th>
<th>Subtractor</th>
<th>Value</th>
<th>Recording</th>
<th>Recording</th>
<th>Display Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>03</td>
<td>1</td>
<td>1.0</td>
<td>100.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>04</td>
<td>0.2</td>
<td>0.2</td>
<td>100.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>05</td>
<td>0.3</td>
<td>0.3</td>
<td>100.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>06</td>
<td>400.0</td>
<td>400.0</td>
<td>100.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>07</td>
<td>5</td>
<td>5</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>08</td>
<td>6</td>
<td>6</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>09</td>
<td>7</td>
<td>7</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>10</td>
<td>8</td>
<td>8</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>11</td>
<td>9</td>
<td>9</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>12</td>
<td>10</td>
<td>10</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>13</td>
<td>11</td>
<td>11</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>14</td>
<td>12</td>
<td>12</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>15</td>
<td>13</td>
<td>13</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>16</td>
<td>14</td>
<td>14</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>17</td>
<td>15</td>
<td>15</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
<tr>
<td>OFF</td>
<td>18</td>
<td>16</td>
<td>16</td>
<td>50.0</td>
<td>None</td>
<td>None</td>
<td>0.0</td>
</tr>
</tbody>
</table>

### Totalize setting

<table>
<thead>
<tr>
<th>Tag No. 1</th>
<th>Tag No. 2</th>
<th>Totalize</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel 1</td>
<td>Channel 2</td>
<td>Channel 3</td>
</tr>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>

### Alarm setting

<table>
<thead>
<tr>
<th>Alarm No. 1</th>
<th>Alarm No. 2</th>
<th>Alarm No. 3</th>
<th>Alarm No. 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Value</td>
<td>Value</td>
<td>Value</td>
</tr>
<tr>
<td>100.0</td>
<td>1</td>
<td>100.0</td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>100.0</td>
<td>1</td>
<td>100.0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

---

INP-TN513551-E

33
### Math channel settings

**Formula**

<table>
<thead>
<tr>
<th>CH19</th>
<th>BO1 = LN(CD1)+SR(CD6)</th>
<th>CH25</th>
<th>BO1 = C25</th>
</tr>
</thead>
<tbody>
<tr>
<td>BO2 = 001+CD1(CD1)</td>
<td>BO2 =</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BO3 = 001+CD1(D01)</td>
<td>BO3 =</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Result = SUN((X13, X10)</td>
<td>Result =</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**CH20**

| BO1 = ABS(G03) + ABS(C06) + ABS(C07) | CH26 | BO1 = C26 |
| BO2 = 001                             | BO2 =                      |
| BO3 = TIE+BO4-LOG(T08)                | BO3 =                      |
| Result = SUN(C01, -C06)-MIN(C01, C08)+POM(T11, C07) | Result =                  |

**CH21**

<table>
<thead>
<tr>
<th>BO1 = C21</th>
<th>CH27</th>
<th>BO1 = C27</th>
</tr>
</thead>
<tbody>
<tr>
<td>BO2 = 001</td>
<td>BO2 =</td>
<td></td>
</tr>
<tr>
<td>BO3 = 001</td>
<td>BO3 =</td>
<td></td>
</tr>
<tr>
<td>Result = 001</td>
<td>Result =</td>
<td></td>
</tr>
</tbody>
</table>

**CH22**

<table>
<thead>
<tr>
<th>BO1 = C22</th>
<th>CH28</th>
<th>BO1 = C28</th>
</tr>
</thead>
<tbody>
<tr>
<td>BO2 = 001</td>
<td>BO2 =</td>
<td></td>
</tr>
<tr>
<td>BO3 = 001</td>
<td>BO3 =</td>
<td></td>
</tr>
<tr>
<td>Result = 001</td>
<td>Result =</td>
<td></td>
</tr>
</tbody>
</table>

**CH23**

<table>
<thead>
<tr>
<th>BO1 = C23</th>
<th>CH29</th>
<th>BO1 = C29</th>
</tr>
</thead>
<tbody>
<tr>
<td>BO2 =</td>
<td>BO2 =</td>
<td></td>
</tr>
<tr>
<td>BO3 =</td>
<td>BO3 =</td>
<td></td>
</tr>
<tr>
<td>Result = 001</td>
<td>Result =</td>
<td></td>
</tr>
</tbody>
</table>

**CH24**

<table>
<thead>
<tr>
<th>BO1 = C24</th>
<th>CH30</th>
<th>BO1 = C30</th>
</tr>
</thead>
<tbody>
<tr>
<td>BO2 =</td>
<td>BO2 =</td>
<td></td>
</tr>
<tr>
<td>BO3 =</td>
<td>BO3 =</td>
<td></td>
</tr>
<tr>
<td>Result = 001</td>
<td>Result =</td>
<td></td>
</tr>
</tbody>
</table>

---

### Totalize settings

**Totalize**

<table>
<thead>
<tr>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
<th>Totalize</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>Calc.</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
<td>Totalize</td>
</tr>
<tr>
<td></td>
<td>Input</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

### Alarm settings

<table>
<thead>
<tr>
<th>Alarm No. 1</th>
<th>Alarm set DD relay</th>
<th>Alarm No. 2</th>
<th>Alarm set DD relay</th>
<th>Alarm No. 3</th>
<th>Alarm set DD relay</th>
<th>Alarm No. 4</th>
<th>Alarm set DD relay</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm type</td>
<td>value No.</td>
<td>value No.</td>
<td>H</td>
<td>value No.</td>
<td>value No.</td>
<td>H</td>
<td>value No.</td>
</tr>
<tr>
<td>CH19 H</td>
<td>159.0</td>
<td>28</td>
<td>L</td>
<td>319.0</td>
<td>4</td>
<td>H</td>
<td>219.0</td>
</tr>
<tr>
<td>CH20 H</td>
<td>0.4200</td>
<td>29</td>
<td>L</td>
<td>0.3200</td>
<td>9</td>
<td>L</td>
<td>0.2200</td>
</tr>
<tr>
<td>CH21 H</td>
<td>7.00E-1</td>
<td>None OFF</td>
<td>L</td>
<td>7.00E-1</td>
<td>None OFF</td>
<td>L</td>
<td>7.00E-1</td>
</tr>
<tr>
<td>CH22 H</td>
<td>22.0</td>
<td>22</td>
<td>L</td>
<td>22.0</td>
<td>22</td>
<td>L</td>
<td>22.0</td>
</tr>
<tr>
<td>CH23 H</td>
<td>4.3200</td>
<td>27</td>
<td>L</td>
<td>3.2400</td>
<td>1</td>
<td>H</td>
<td>2.2400</td>
</tr>
<tr>
<td>CH24 H</td>
<td>25.0</td>
<td>25</td>
<td>L</td>
<td>325.0</td>
<td>10</td>
<td>L</td>
<td>225.0</td>
</tr>
<tr>
<td>CH25 H</td>
<td>41.26</td>
<td>25</td>
<td>L</td>
<td>226.0</td>
<td>9</td>
<td>L</td>
<td>226.0</td>
</tr>
<tr>
<td>CH26 H</td>
<td>0.370</td>
<td>12</td>
<td>H</td>
<td>0.370</td>
<td>12</td>
<td>H</td>
<td>0.370</td>
</tr>
<tr>
<td>CH27 H</td>
<td>4.280</td>
<td>28</td>
<td>L</td>
<td>3.280</td>
<td>4</td>
<td>L</td>
<td>2.280</td>
</tr>
<tr>
<td>CH28 H</td>
<td>4.280</td>
<td>28</td>
<td>L</td>
<td>3.280</td>
<td>4</td>
<td>L</td>
<td>2.280</td>
</tr>
<tr>
<td>CH29 H</td>
<td>4.280</td>
<td>28</td>
<td>L</td>
<td>3.280</td>
<td>4</td>
<td>L</td>
<td>2.280</td>
</tr>
<tr>
<td>CH30 H</td>
<td>4.280</td>
<td>28</td>
<td>L</td>
<td>3.280</td>
<td>4</td>
<td>L</td>
<td>2.280</td>
</tr>
</tbody>
</table>

---

### Notes

1. **Color**
   - Tag No. 1: TA510
   - Tag No. 2: TA520
   - Input unit: f/d
   - Min: 0.0120
   - Max: 0.5200
   - Engineering unit: 0.0120
   - Range: 0.5200

2. **Log**
   - Input filter: PV shift
   - PV gain: calc.
   - Fvalue: channel calc.
   - Recording: mode type
   - Recording: Min: 0.0120
   - Min: 0.5200
   - Display range: 0.0120
   - 0.5200

---

**INP-TN513551-E**

---

**34**
### Main settings
- Display refreshment cycle: 1 sec
- Alarm hysteresis: 1.32 (%)
- LCD lights out-time: 0 min
- Recording data format: Binary
- Configuration password: 1
- Trend back color: White
- Historical back color: Black
- Value calculation setting:
  - Target temperature: 100.0 °C
  - Value: 200.0 °C
  - Decimal point position: 3
  - Reset temperature: 10.0 °C
- Totalize setting:
  - Daily totalize cycle: 12 hour
  - Annual base day: 31
  - External input: D11
- Program version: V4A
- Exclusive use totalize setting:
  - Totalize calculation OFF
  - Totalize base time: h
  - Totalize recording cycle: 12 hour
  - Start/Stop timing manual:
    - Start time: 23:06
    - Stop time: 22:00
- Math timer setting:
  - H-P/L-P operation: 2 min
  - AVG operation: 4 min
  - SUN operation: 2 min

### Display setting
- Content of screen composition:
- Display group 1: Channel 1, Channel 13
  - Channel 14
  - Channel 15
  - Channel 16
  - Channel 17
  - Channel 18
  - Channel 19
  - Channel 20
- Display group 2: Channel 1, Channel 11
  - Channel 12
  - Channel 13
  - Channel 14
  - Channel 15
  - Channel 16
  - Channel 17
  - Channel 18
  - Channel 19
- Display group 3: Channel 1, Channel 11
  - Channel 12
  - Channel 13
  - Channel 14
  - Channel 15
  - Channel 16
  - Channel 17
  - Channel 18
  - Channel 19
- Display group 4: Channel 1, Channel 11
  - Channel 12
  - Channel 13
  - Channel 14
  - Channel 15
  - Channel 16
  - Channel 17
  - Channel 18
  - Channel 19

### Display name
- Trend: Vertical
- Display: 20
- Scale: Bar graph
- Bar graph/Tag No. display: ON
- Color bar: Tag No. display: ON
- Display group 1, Display group 2, Display group 3, Display group 4

### Message setting
- Message 1: D1 ON
- Message 2: D1 OFF
- Message 3: Channel 1 Alarm No. 1 ON
- Message 4: Channel 18 Alarm No. 1 OFF
- Message 5: Channel 14 ON
- Message 6: Channel 18 Alarm No. 3 OFF
- Message 7: Channel 18 Alarm No. 2 ON
- Message 8: Channel 14 OFF
- Message 9: Channel 14 Alarm No. 4 OFF
- Message 10: Channel 18 Alarm No. 2 OFF

### Original Unit definition
- Unit
  - No. 1: nPa
  - No. 2: SEQ
  - No. 3: No. 4
  - No. 5
  - No. 6
  - No. 7
  - No. 8
  - No. 9
  - No. 10
  - No. 11
  - No. 12

### D1 function setting
- D1-1: Recap start/Rec stop
- D1-2: Recap calc. reset
- D1-3: Totalize start/stop
- D1-4: Function invalid
- D1-5: Recap start/Rec stop

### Constant setting
- Constant 1: 1
- Constant 2: 2
- Constant 3: 3.0
- Constant 4: 4.00
- Constant 5: 5.000
- Constant 6: 60
- Constant 7: 700
- Constant 8: 8000
- Constant 9: 0.9
- Constant 10: 0.01

**INP-TN513551-E 35**
Ethernet setting

IP Address 192.168.0.2
Subnet mask 255.255.255.0
Default gateway 0.0.0.0

FTP server setting
FTP server function ON
Access control ON

Web Server setting
Web server function ON

E-mail setting
E-mail function ON

MODBUS TCP/IP setting
MODBUS TCP/IP function ON

Communication setting
Modbus station No. 1 Modbus baud rate 19200 bps Modbus parity Odd

User account setting

<table>
<thead>
<tr>
<th>User name</th>
<th>Password</th>
<th>User level</th>
</tr>
</thead>
<tbody>
<tr>
<td>System-Taro</td>
<td>a10b23</td>
<td>administrator</td>
</tr>
<tr>
<td>Kiroku-Kaiko</td>
<td>65790</td>
<td>guest</td>
</tr>
<tr>
<td>3.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td></td>
<td>administrator</td>
</tr>
<tr>
<td>6.</td>
<td></td>
<td>adminstrator</td>
</tr>
<tr>
<td>7.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.</td>
<td></td>
<td>administrator</td>
</tr>
</tbody>
</table>

E-mail setting

| SWIP (Mail server) IP address | 192.168.0.1 |
| Sender's mail address        | boiler035@test.co.jp |
| Sender's name                 | boiler035 |

Receiver's mail address
1. System-Taro@test.co.jp
2. Kiroku-Kaiho@test.co.jp
3. 
4. 
5. 
6. 
7. 
8. 

E-mail trigger setting

<table>
<thead>
<tr>
<th>Title</th>
<th>Text 1</th>
<th>Text 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. 1</td>
<td>Product manufacturing beginning</td>
<td>Boiler035</td>
</tr>
<tr>
<td>No. 2</td>
<td>Boiler035 report at regular time</td>
<td>Report at regular time</td>
</tr>
<tr>
<td>No. 3</td>
<td>The temperature is abnormal</td>
<td>The temperature is abnormal</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trigger timing</th>
<th>Timing1</th>
<th>Timing2</th>
<th>PV Value</th>
<th>N0</th>
<th>N1</th>
<th>N2</th>
<th>N3</th>
<th>N4</th>
<th>N5</th>
<th>N6</th>
<th>N7</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. 1 D1 ON</td>
<td>D12</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>No. 2 Timer cycle</td>
<td>12 hour</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>No. 3 Alarm ON</td>
<td>channel1</td>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>No. 4 None</td>
<td>-</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>No. 5 None</td>
<td>-</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>No. 6 None</td>
<td>-</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>No. 7 None</td>
<td>-</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>No. 8 None</td>
<td>-</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>No. 9 None</td>
<td>-</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>No. 10 None</td>
<td>-</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
</tbody>
</table>